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Conventions Used in this Guide

Please take amoment to review how instructions and other useful information are presented in this
guide.

l Procedures are presented as numbered lists. A single bullet indicates that the procedure
has only one step.

l Bold type is used for the following:
o Keyboard entries that should be typed in their entirety exactly as shown. For example,
“copy file1” means the word copymust be typed, then a spacemust be typed, and
then file1must be typed.

o On-screen prompts andmessages, names of options and text boxes, andmenu com-
mands. Menu commands are often separated by carats. For example, “click
HFSS>Excitations>Assign>Wave Port.”

o Labeled keys on the computer keyboard. For example, “PressEnter” means to press
the key labeledEnter.

l Italic type is used for the following:
o Emphasis.
o The titles of publications.
o Keyboard entries when a name or a variablemust be typed in place of the words in ital-
ics. For example, “copy file name” the word copymust be typed, then a spacemust
be typed, and then name of the file must be typed.

l The plus sign (+) is used between keyboard keys to indicate that you should press the keys
at the same time. For example, “Press Shift+F1” means to press the Shift key and the F1
key at the same time.

Ribbons, menu bars, and short-cut menus are threemethods that can be used to see what
commands are available in the application.

l Ribbons are the rectangular area on top of the application window and contain multiple tabs.
Each tab has relevant commands that are organized, grouped, and labeled. An example of a
typical user interaction is as follows:

"On theDraw ribbon tab, click theBox primitive" means you can click theBox icon on the
Draw tab and execute theBox command to draw a box.

l Themenu bar (located above the ribbon) is a group of themain commands of an application
arranged by category such File, Edit, View, Project, etc. An example of a typical user inter-
action is as follows:

"On the Filemenu, click theOpen Examples command"means you can click the Filemenu
and then clickOpen Examples to launch the dialog box.

l Another alternative is to use the short-cut menu that appears when you click the right-mouse
button. An example of a typical user interaction is as follows:
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“Right-click and selectAssign Excitation> Wave Port” meanswhen you click the right-
mouse button with an object face selected, you can execute the excitation commands from
the short-cut menu (and the corresponding sub-menus).

Getting Help: ANSYS Technical Support

For information about ANSYS Technical Support, go to the ANSYS corporate Support website,
https://www.ansys.com/Support. You can also contact your ANSYS account manager in order to
obtain this information.

All ANSYS software files are ASCII text and can be sent conveniently by e-mail. When reporting dif-
ficulties, it is extremely helpful to include very specific information about what stepswere taken or
what stages the simulation reached, including software files as applicable. This allowsmore rapid
and effective debugging.

Help Menu

To access help from themenu bar, clickHelp and select from themenu:

l HFSS Contents - click here to open the contents of the help.
l HFSS Search - click here to open the search function of the online help.

Context-Sensitive Help

To access help from the user interface, do one of the following:

l To open a help topic about a specificmenu command, pressShift+F1, and then click the
command or toolbar icon.

l To open a help topic about a specific dialog box, open the dialog box, and then pressF1.
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1 - Introduction
This document describes how to optimize themodel created in the previousWaveguide T-Junction
getting started guide. It includes instructions to set up and solve a basic parametric analysis and to
create and solve an optimization setup. It also shows how to import the T-Junction geometry to
SpaceClaim and to link it with HFSS (connecting CAD model variables to HFSS design para-
meters). Changes from the HFSS optimization analysis are reflected in the linked SpaceClaim geo-
metry.

This chapter contains the following topics:
l Prerequisites
l What YouWill Learn
l HFSS Optimetrics
l T-Junction Recap and Sample Project Overview

Prerequisites
We strongly recommend that you complete the tutorialGetting Started with HFSS: AWaveguide
T-Junction before you work on this exercise. The parametric and optimization setups for this project
are based on the design setup, analyses, and post processing performed in theWaveguide T-Junc-
tion tutorial. However, an example Teemodel is included as part of the ANSYS Electronics
Desktop installation. It is identical to themodel created via the prerequisite guide, except that the
results have not been computed yet. However, the analysis setup, sweep, S-parameter plot, and
E-field overlay are already defined. If you choose to complete this exercise without completing the
prerequisite tutorial, the example Teemodel provides themeans to do so.

If you want to complete the optional SpaceClaim link exercise (in the last chapter of this guide), you
will need to have theANSYSWorkbenchapplication installed, which includes theSpaceClaim
CAD solid modeling product.

What You Will Learn
Youwill learn to perform the following HFSS tasks in the ANSYS Electronics Desktop application:

l Create a basic parametric setup.
l Solve a parametric analysis.
l Create a 2D x-y plot of S-parameter results.
l Create a 2D x-y plot of power distribution results.
l Create a geometry animation.
l Specify an optimization variable.
l Create an optimization setup, which includes defining a cost function and setting the range of
variable values for an optimization.

l Run an optimization analysis.

Getting Started with HFSS: Optimizing aWaveguide T Junction and Using SpaceClaim Link
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l During an optimization analysis, create a plot of cost values versus solved iterations.
l Run an HFSS simulation using the optimal variable value.
l Update an existing field overlay plot with new results.
l If you continue to the SpaceClaim link exercise, you will learn to export geometry from the
Modeler and import it into SpaceClaim.

l Youwill also learn to create a variable in SpaceClaim, save a project, and connect
fromHFSS using the SpaceClaim link.

l Youwill then solve the geometry parametrically in HFSS usingOptimetrics, demon-
strating a bidirectional workflow between SpaceClaim 3D CAD and ANSYS Elec-
tronics Desktop.

HFSS Optimetrics
Optimetrics is a feature that automates the process of determining the best design variation among
a number of possible options. Create the original model and define the design parameters that
vary. These parameters can be nearly any design characteristic assigned a numeric value in
HFSS. For example, you can parameterize themodel geometry, material properties, or boundary
conditions. You can then perform the following types of analyses on your nominal design:

Parametric Define one or more variable sweep definitions, each specifying a series of
variable valueswithin a range, and HFSS solves the design at each vari-
ation. Parametric analyses are often used as precursors to optimization
solutions because they help to determine a reasonable range of variable val-
ues for the optimization analysis.

Optimization Identify the cost function and the optimization goal. Optimetrics changes the
design parameter values tomeet that goal.

Sensitivity Optimetrics explores the space in the vicinity of the design point to determ-
ine the sensitivity of the design to small changes in variables.

Tuning Tuning allows you to change variable values interactively while monitoring
the performance of the design.

Statistical Optimetrics allows you to explore the effects of various combinations of
selected variables on specified analysis results. These effects are presen-
ted as a statistical distribution of a user-specified type (such asUniform,
Gaussian, or other types).

Introduction 1-2
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Design of
Experiments

Design of Experiments (DOE) is a technique used to scientifically determ-
ine the location of sampling points and is included as part of the Response
Surface, Goal DrivenOptimization, and Analysis systems.

DesignXplorer An optimization tool, used with Design of Experiments (DOE), for studying
a range of design variations. It can launch ANSYS Electronics Desktop and
manage DOE and optimization simulations.

Note:

In this guide, you will perform aParametric analysis and anOptimization analysis.

T-Junction Recap and Sample Project Overview
In this topic, we review theGetting Started with HFSS: AWaveguide T Junction exercise, which is
a prerequisite to this optimization exercise. We also discuss the samplemodel for the optimization
and the expected results.

Recap of the Tee Waveguide Junction Project:

InGetting Started with HFSS: AWaveguide T-Junction, you created a T-shaped waveguide with
an inductive septum.[1]A signal at a frequency of 10GHz entered the waveguide at Port1 (see
below) and exited at Port2 and Port3.

Introduction 1-3
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Figure 1-1: The T-Junction

Thewaveguide’s transmission and reflection of the signal depended on the Y-position of the
septum. You assigned a variable to the septum’s position, namedOffset, and solved the design at
twoOffset values.When the septumwas located centrally between Port2 and Port3, opposite
Port1 (Offset = 0 inches), the septum divided the signal and directed it evenly toward the output
ports, Port2 and Port3. When the septumwasmoved 0.2 inches closer to Port2 (Offset = 0.2
inches), the transmission through Port2 decreased, and the transmission through Port3 increased.
Also, the signal reflection at Port1 decreased somewhat with the septum in the offset position.

[1] “Parametrics andOptimization Using Ansoft HFSS,” Microwave Journal, Product Reviews,
November 1999.

Sample Project: Tee Waveguide Optimization

In this project, use theOptimetrics feature in HFSS to find an optimal position for the septum as
defined by theOffset variable. The optimal position is that which results in the power distribution at
Port3 being twice that at Port2. The function of this power distribution (that is, P31 - 2*P21) is
called the cost function. At a resultant cost of zero, P31 = 2*P21, which is the design objective. In
Optimetrics, we want to select the optimal position from a series of available alternatives and solve
the corresponding designs until theminimum cost is achieved. One such series of available altern-
atives is the range of values for the offset.

Note:

The cost function can be based on any solution quantity that HFSS can compute, such as
field values, S-parameters, and eigenmode data.

Important:

To preserve your previousTeemodel, you will save a copy of it with a new name
(OptimTee). Alternatively, if you choose to use the preinstalled Tee examplemodel, you
must save it asOptimTee to a working folder of your choice, since writing to theExamples
folders is not permitted.

Before optimization, you will set up and solve a parametric analysis. The parametric setup will
define a range of values for theOffset variable. During the parametric analysis, Optimetrics solves
the design at each variation. Results are compared to see how each design variation affects the S-
parameters and power distribution within the structure. These results help ascertain a range ofOff-
set values for the subsequent optimization analysis. The results also help Optimetrics determine an
acceptable starting point for the optimization analysis.

Expected Results:

Introduction 1-4
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We saw in theWaveguide T-Junction project that, when the septum is located centrally opposite to
Port1, it directs the signal evenly toward the output ports, Port2 and Port3. The parametric analysis
is expected to show that as the septummoves closer toward Port2, the transmission and power dis-
tribution initially decrease at Port2 and increase at Port3. As the septum continues tomove closer
toward Port2, the signal should begin to bounce off of the T-junction wall opposite Port1, more of
the signal will be reflected, and the performance of the structure will degrade.

To verify whether the parametric results are as expected, compare the S-parameter calculations at
each septum position on a 2D x-y plot. Create a second x-y plot that compares the power dis-
tribution at each port as the septum changes position. You can also create an animated field plot on
themodel geometry, which will indicate if the field pattern changes are as expected as the septum’s
position is changed. This parametric analysis post processing provides useful information for set-
ting up the optimization analysis that follows. For example, post processing should reveal the
septum position that will most likely result in the power distribution at Port3 being twice that at
Port2. It will also allow you to narrow the range of variable values you will set for the optimization.

The optimization analysis should reveal that the optimal septum position lies between 0 and 0.2
inches. You will re-analyze the design at the optimal position and then update the field overlay plot
you created in the previous project (Waveguide T-Junction). The E-field values should indicate that
the fields are twice as great moving toward Port 3 as they aremoving toward Port 2.

Introduction 1-5
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2 - Set Up the Optimized Tee
This chapter contains the following topics:

l Open theModel
l Delete Frequency Sweep
l Add Parametric Setup
l Specify Quantities for Post Processing
l Solve the Parametric Analysis

Open the Model
Your actions in this procedure depend on whether you've completed the prerequisite tutorial,Get-
ting Started with HFSS: AWaveguide Tee Junction and, if so, whether that model is already open.

1. Launch the ANSYS Electronics Desktop application if it is not already running.
2. Close any open projects except for the prerequisite tutorial'sTeemodel (right-click the pro-

ject and chooseClose from the shortcut menu).
3. Choose one of the following three actions:

l If you've completed the prerequisite tutorial and have proceeded directly to this exer-
cise with themodel still open, skip to step 4.

l If you previously completed the prerequisite tutorial, but themodel is no longer open,

click Open on theDesktop ribbon tab, navigate to your model storage location,
and select Tee.aedt. Then clickOpen to load themodel.

l If you have not completed the prerequisite tutorial, click Open Examples on the
Desktop ribbon tab, double-click theHFSS subfolder under Examples in theOpen
dialog box, and then double-click theRF Microwave subfolder. Finally, select the file
Tee.aedt and clickOpen to load themodel.

4. On theDesktop ribbon tab, click Save As.

TheSave As dialog box appears.

5. Navigate to a working folder of your choice where you want to store the optimizationmodel
files.

6. In the File name text box, specifyOptimTee

7. On any ribbon tab, click Save.

Set Up theOptimized Tee 2-1
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Note:

There are a couple of inconsequential differences between themodel built in the pre-
requisite tutorial and the preinstalled examplemodel:

l The images included in this guide were captured from themodel built in the pre-
requisite tutorial and are based on the software's default material appearance
attributes at that time. Thematerial color and transparency attributes of the pre-
installed examplemodel are different. Therefore, if you are using the preinstalled
examplemodel, the color and transparencywill differ from the images in this guide.

l The initial position of the Septum depends on whichmodel you open. At the end of
the previous tutorial, the Septum is at an offset position (specifically, 0.2 inches off-
center, moved toward Port2). However, the examplemodel has the Septum at the
zero-offset position (centered between Port2 and Port3).

Since you will specify the range of offset values for the subsequent parametric ana-
lysis, the initial position of the Septum is inconsequential.

Delete the Frequency Sweep
When you solve the parametric and optimization analyses later in this guide, you will solve at the
solution frequency you specified in theDriven Solution Setup dialog box (10GHz). You do not
need to solve across a range of frequencies for each design variation; you will optimize the Tee at a
fixed frequency of 10GHz. Therefore, delete the previously defined frequency sweep, as follows:

1. Under Analysis> Setup1 in the Project Manager, right-clickSweep1 and selectDelete from
the short-cut menu:

Figure 2-1: Deleting Frequency Sweep

Set Up theOptimized Tee 2-2
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You are now ready to begin setting up the parametric analysis.

Add a Parametric Setup
A parametric setup specifies all of the design variations that Optimetrics will drive HFSS to solve. A
parametric setup ismade up of one or more variable sweep definitions, each specifying a set of vari-
able valueswithin a range that you want HFSS to solve when you run the parametric setup.

You can add the parametric setup to the project as follows:

1. On theSimulation ribbon tab, click Optimetrics> Parametric.

Alternatively, you can right-clickOptimetrics in the Project Manager and chooseAdd>
Parametricfrom the short-cut menu.

TheSetup Sweep Analysis dialog box appears.

Figure 2-2: Setup Sweep Analysis Dialog Box

2. ClickAdd.

TheAdd/Edit Sweep dialog box appears.

Set Up theOptimized Tee 2-3
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3. Edit the entries as shown in the following figure:

Figure 2-3: Add/Edit Sweep Dialog Box

Note:

TheStep value is the calculation increment and determines the number of design
variations between theStart andStop values. HFSS will solve themodel at each
step in the specified range, including the Start and Stop values.

4. ClickAdd>> to create the parametric sweep setup.

TheVariable andDescription appear in the right half of the dialog box:

Set Up theOptimized Tee 2-4
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Figure 2-4: Parametric Sweep Variable and Description

5. ClickOK.

The sweep setup appears in theSetup Sweep Analysis dialog box:

Figure 2-5: Parametric Sweep Added

6. Select the Table tab.

The table lists the different values of offset per your settings.

Set Up theOptimized Tee 2-5
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Figure 2-6: Table Listing Offset Values

7. Under theOptions tab, select theSave Fields and Mesh option:

Figure 2-7: Setup Sweep Analysis – Options Tab

8. Leave theSetup Sweep Analysis dialog box open. You will continue to use it in the next
topic.

Specify Quantities for Post Processing
Youwill now identify three solution quantities that will be of interest during post processing. HFSS
will extract the solution quantities andmake them available during post processing. You will create
three output variables that represent themathematical expressions for the power distribution quant-
ities at Port1, Port2, and Port3.

1. If you did not leave the Setup Sweep Analysis dialog box open from the preceding topic,
double-clickParametricSetup1 underOptimetrics in the Project Manager to reopen it.

2. Select theCalculations tab.
3. ClickSetup Calculations.

TheAdd/Edit Calculation dialog box appears.

Set Up theOptimized Tee 2-6
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Figure 2-8: Add/Edit Calculation Dialog Box

4. ClickOutput Variables.

TheOutput Variables dialog box appears.

5. Make the following entries:
l TypePower11 in theName field.
l SelectS Parameter from theCategory drop-downmenu.
l SelectS(Port1,Port1) in theQuantity list.
l Selectmag in the Function list.

Set Up theOptimized Tee 2-7
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Figure 2-9: Defining Power11 Output Variable

6. Click Insert Into Expression.
7. In theExpression text box, type ^2 at the end of the expression (to square the S-parameter

magnitude):

Figure 2-10: Modified Power11 Expression

8. ClickAdd to include the specified variable in theOutput Variables list.
9. In the samemanner, define twomore variables,Power21 andPower31, as follows:

a. Power 21 =mag(S(2,1))^2
b. Power 31 =mag(S(3,1))^2

Set Up theOptimized Tee 2-8
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Note:

ClickAdd each time after defining the variablesPower21 andPower31 to include
them in theOutput Variables list, which should look like the following figure when
you're done:

Figure 2-11: Output Variables

10. ClickDone.

TheOutput Variables dialog box closes.

11. In theAdd/Edit Calculation dialog box, selectOutput Variables in theCategory list.

The Trace tab of theAdd/Edit Calculation dialog box lists all of output variables you just
defined, as shown in the following figure:

Figure 2-12: Calculation Expression tab

12. WithPower11 selected in theQuantity list, clickAdd Calculation.

Power11 is added to the table in theCalculations tab of theSetup Sweep Analysis dialog
box.

13. In the samemanner, selectPower21 andPower31, in turn, and add each of them to theCal-
culations table.

Set Up theOptimized Tee 2-9
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Figure 2-13: Post Processing Quantities Defined for Parametric Sweep Analysis

Note:

By default, the calculation range is set to the single frequency 10GHz (the adaptive
frequency defined in the solution setup). So, the solution quantity will be extracted
from the solution at this frequency.

14. ClickDone to close theAdd/Edit Calculation dialog box andOK to close theSetup Sweep
Analysis dialog box.

This step completes the parametric sweep setup definitions.

15. It's a good time to Save your model.

Solve the Parametric Analysis
Youwill now run the parametric analysis to generate results for the T-junction for different positions
of the septum specified in the variable sweep definition.

1. Right-clickParametricSetup1 underOptimetrics in the Project Manager and clickAnalyze
from the shortcut menu.

HFSS computes the S-parameters and the 3D field solution for every previously unsolved
design variation that you specified in the parametric setup.

Note:

If theProgresswindow is not visible, clickShow Progress at the lower right corner
of the ANSYS Electronics Desktop window.

The solution process is expected to take approximately 3minutes. When the solution is complete, a
confirmationmessage appears in theMessageManagerwindow. To see themessages, youmay
need to clickShow Messages near the lower right corner of the application window.

Set Up theOptimized Tee 2-10
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3 - Review Parametric Results
This chapter contains the following topics:

l S-Parameter Results vs. Offset Position
l Power Distribution vs. Offset Position
l Animate the Field Overlay Plot

You will begin by creating two rectangular plots of the results.

S-Parameter Results vs. Septum Offset
With the parametric setup solved, you can now create a 2D (rectangular) plot that compares the S-
parameter results at each port for each solved septum position (Offset).

1. On theResults ribbon tab, click Modal Solution Data Report> 2D.

TheReport dialog box appears.

2. In theContext section, ensure that Setup 1: Last Adaptive is selected from theSolution
drop-downmenu.

3. Under the Trace tab, specify the following settings:
a. From thePrimary Sweep drop-downmenu, chooseOffset.

Note:

By default, the variable isFreq, which HFSS recognizes as the frequency at
which the solution was generated. For this exercise, you want the X-axis to
show the sweep of allOffset values that were solved during the analysis.

b. Ensure that S Parameter is selected in theCategory list.
c. In theQuantity list, selectS(Port1,Port1), S(Port1,Port2), andS(Port1,Port3).

Note:

TheY: text box lists the selected quantities, delimited by semi-colons.

d. In the Function list, selectmag.
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Figure 3-1: Report Dialog Box – Trace Tab

4. Ensure thatAll is specified to the right of Primary Sweep: Offset. If not, click the elipsis but-
ton (...) and select theUse all values option from the dialog box that appears.

Figure 3-2: Report Dialog Box – Families Tab
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5. ClickNew Report but keep theReport dialog box open for now.

Themagnitudes of each of the specified S-parameters are plotted against theOffset values
on an X-Y graph. The new plot appears underResults in the Project Manager along with its
three traces.

6. If needed, drag theReport dialog box out of the way of the plot window so that you can
modify and reposition the plot legend. But again, keep theReport dialog box open for now.

7. Simplify the plot legend by double-clickingCurve Info in the legend to access the plot Prop-
erties dialog box. Then, make the following changes under the Legend tab:

a. Deselect theShow Variation Key andShow Solution Name options.
b. ClickOK.
c. Click and drag the legend to a location that doesn't obscure any of the traces.

Your plot should look like the following figure:

Figure 3-3: XY Plot – S Parameters vs. Septum Offset
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Note:

For each value ofOffset, the red line shows the S-parameter values at Port 1, the
green line shows the S-parameter values at Port 2, and the blue line shows the S-
parameter values at Port3.

Observations:
l As the septummoves closer to Port2, the transmission decreases at Port2
and initially increases at Port 3.

l As the septum ismovedmore than 0.3 inches toward Port2, it becomes less
effective at steering the signal toward Port3, and the transmission begins to
decrease at Port3. Additionally, reflection increases at the input port (Port1)
as the signal bounces back from the T-junction wall opposite the port.

l Beyond 0.6 inches of Offset, the effect on transmission at Port2 becomes rel-
atively insignificant and the curve levels off.

l Beyond 0.75 inches of Offset, the reflection at Port1 has peaked and begins
to decrease again. At the same time, the transmission at Port3 has reached
itsminimumand begins to increase again.

Power Distribution vs. Offset Position
Now you will create a 2D plot that compares the power distribution results at each port for each
solved septum position (Offset). The report dialog box should still be open from the prior plot defin-
ition procedure.

1. Specify the following settings:
a. In theCategory list, selectOutput Variables.
b. In theQuantity list, selectPower11, Power21, andPower31.

The Y text box lists the selected quantities, delimited by semi-colons.

c. In the Function list, click <none>.
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Note:

If you didn't leave theReport dialog box open from the previous plot definition pro-
cedure and had to repeat the 2D/Rectangular plot command, you will have to once
again change thePrimary Sweep setting toOffset. Otherwise, the prior plot set-
tings are retained.

Your new plot settings shouldmatch the following figure:

Figure 3-4: Report Dialog Box – Plot 2 Settings

2. ClickNew Report andClose.

The power distribution at each port is plotted against eachOffset value on an X-Y graph. The
new plot is listed underResults in the Project Manager along with its three traces.

3. Simplify the plot legend by double-clickingCurve Info in the legend to access the plot Prop-
erties dialog box. Then, make the following changes under the Legend tab:

a. Deselect theShow Variation Key andShow Solution Name options.
b. ClickOK.
c. Click and drag the legend to a location that doesn't obscure any of the traces.

Your plot should look like the following figure:
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Figure 3-5: Power vs. Offset Plot

Note:

For each value ofOffset, the red line shows the power at Port1, the green line
shows the power at Port2, and the blue line shows the at Port3. The three traces
are qualitatively the same as the previous S-parameter plot, but themagnitude of
the Y values are different. This plot shows the distribution of 1 watt of power at the
3 ports as the septum’s positionmoves closer to Port2.
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Important:

Recall that the goal for the optimization analysis is to find the septum position that
results in the power distributed to Port3 being twice asmuch as the power dis-
tributed to Port2. Notice that when theOffset is 0.1 inch, the value of Power21 is
approximately 0.31, and Power31 is approximately 0.66, or a little more than twice
asmuch. Therefore, you will set the starting value for the optimization to be 0.1
inches. The next chapter includesmore details about setting the starting value.

4. You can add a Y-marker to the plot to make determining the power levels atOffset = 0.1 inch
easier. To do so, right-click the plot and chooseMarker> Add Y Marker. Then, drag the
marker vertically to see the X and Y values at any point along the traces, as shown below:

Figure 3-6: Using the Y Marker

5. To remove the Y Marker, right-click on the plot and chooseMarker> Clear All.

Animate the Field Overlay
Re-animate the field overlay plot you created inGetting Started with HFSS: AWaveguide T-Junc-
tion. This time, you will plot the E-field at each solved value ofOffset to see how the field is affected
by the septum’s position.

1. Click in theModelerwindow tomake it active and bring it to the foreground. If theModeler
window is completely covered by your plots, use theWindowmenu to select it.

2. Under Field Overlays> E Field in the Project Manager, right-clickMag_E1 and chooseAnim-
ate from the shortcut menu.
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TheSelect Animation dialog box appears.

3. ClickNew.

TheCreate Animation Setup dialog box appears.

4. Under theSwept Variable tab, chooseSingle variable andOffset from the two drop-
downmenus.

By default, all values of offset are selected to be included in the animation.

Figure 3-7: Create Animation Setup Dialog Box

5. ClickOK.

The animation begins to play in theModeler window. It will display the field plot at each
solvedOffset value between 0 and 1.0 inch, resulting in a total of 11 frames.

6. Reduce the animationSpeed to itsminimum setting so that you have time to see the field pat-
tern for each septum position. Youmay also want to stop the animation and drag the Frame
slider manually to study the results at specificOffset values.
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Figure 3-8: Mag_E1 Field Animation at Three Septum Positions

Observations:

l The plot shows that, at Offset = 0 inch, the fields approaching Port2 and
Port3 are balanced.

l WhenOffset is between 0.1 and 0.3 inches, inclusively, more of the elec-
tromagnetic wavemoves toward Port 3.

l WhenOffset is equal to or greater than 0.4 inches, the fields begin to bounce
back toward Port1, as indicated by the intensified field strength in themiddle
leg of the tee. (The septum becomes less effective at steering the wave
toward Port2 and Port3.)

Based on these observations, you will request that Optimetrics only considerOffset values
between 0 and 0.3 inches during the optimization.

7. In theAnimation dialog box, clickClose.

You are now ready to set up the optimization analysis.
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4 - Optimization Analysis
This chapter contains the following topics:

l Set the Optimization Variable
l Add anOptimization Setup
l Add a Cost Function
l Modify StartingMin, andMaxValues
l Solve theOptimization Analysis
l Optional Exercise

You will begin by choosing the variable to be optimized.

Set the Optimization Variable
In this project, the variable to be optimized isOffset.

1. ClickHFSS> Design Properties.

TheProperties dialog box appears.

2. ClickOptimization / Design of Experiments.
3. Select the Include option next toOffset.
4. ClickOK.

Add an Optimization Setup
In an optimization setup, define a cost function, which specifies one or more goals and guidelines to
minimize the cost function.

1. On the Simulation ribbon tab, click Optimetrics> Optimization.

TheSetupOptimization dialog box appears.

2. Under theGoals tab, selectQuasi Newton (Gradient) from theOptimizer drop-down
menu.
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Figure 4-1: Optimizer and Max Iterations Settings

Note:

If you have a sense of where the extremumwill lie, thenQuasi Newton is a good
choice. In this case, the cost function that needs to beminimized is dependent on
the range of the offset values that you already know falls within 0 to 0.2 inch.

3. Verify thatMax. No. of Iterations = 1000.

Keep the dialog box open and continue to the next topic.

Add a Cost Function
Define a cost function so that the power at Port3 - 2*(the power at Port2) = 0 at the optimal point.
Use the output variables defined earlier to represent this expression. Specify that a cost function
value less than 0.001 is acceptable.

1. Under theGoals tab, clickSetup Calculations.

TheAdd/Edit Calculation dialog box appears.

2. SelectOutput Variables in theCategory list andPower31 in theQuantity list.
3. Modify theCalculation Expression by appending -2*Power21 toPower31. The complete

expression should bePower31-2*Power21, as shown in the following figure:

Figure 4-2: Add/Edit Calculation Dialog Box – Calculation Expression
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4. PressAdd Calculation and thenDone to close theAdd Edit Calculation dialog box.

A new row is added to theCost Function table.

Note:

By default, the cost function will be extracted from the last adaptive solution gen-
erated for the solution setup.

5. Specify the following settings:
l LeaveCondition set to “=”.
l In theGoal column, type 0.
l In theWeight column, keep [1].
l In theAcceptable Cost text box, type 0.001.
l In theNoise text box, keep 0.0001.

Figure 4-3: Cost Function Calculation added

Note:

By default, the calculation range of this quantity is set to 10GHz, the adaptive fre-
quency defined in the solution setup. The solution quantity will be extracted from
the solution at this frequency.

Keep the dialog box open and proceed to the next topic.
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Modify Starting, Min, and Max Values
Weexpect the optimum offset to fall between 0 and 0.2 inches and to be close to 0.1 inch. You can
set the variable'sminimum, maximum, and starting values accordingly so that the optimizer
focuses closely on the expected solution area.

1. Select theVariables tab.

One variable, namelyOffset, is listed under this tab, since it is the only optimization variable
defined.

2. Specify the following settings for the Offset variable:
a. Type 0.1 as theStarting Value and then pressEnter.

TheOverride option is selected automatically, andOptimetrics will work with 0.1
regardless of the previous value ofOffset used for the simulation.

b. Type 0 as theMin value and pressEnter.
c. Type 0.2 as theMax value and pressEnter.

Figure 4-4: Setup Optimization Dialog Box – Variables Tab

3. Keep the dialog box open and proceed to the next topic.

Solve the Optimization Analysis
1. Select theGeneral tab.
2. From theParametrics Analysis drop-downmenu, ensure thatN/A (not applicable) is selec-

ted:
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Figure 4-5: Setup Optimization Dialog Box – General Tab

Note:

If you were to choose the previously solvedParametricSetup1, the programwould
ignore theStarting Value forOffset that you specified under theVariables tab.
Instead, it would evaluate the entire previous parametric sweep (including those off-
sets outside of theMin value toMax value range defined inOptimizationSetup1),
and it would automatically determine a suitable starting point for the optimization
iterations.

After running the optimization analysis, the analysis results table or plot will show the fol-
lowing information, depending on whichParametrics Analysis option you choose:

l N/A: The starting value will be 0.1, as specified as anOverride under theVariable tab.
(Note that the results at this septum offset already exist from the prior parametric
sweep, so the cost can be evaluated without re-solving for this startingOffset value.)
Three additional iterations (based on previously unsolvedOffset values) will be per-
formed before the goal is satisfied. The analysis results table will therefore show a
total of four data points.

l ParametricSetup1: Every septum offset value from the previous parametric analysis
results (between 0 and 1 inch, inclusively, in 0.1 inch increments) will be evaluated.
Again, re-solving is not required but only cost evaluation for the already calculated res-
ults. These elevenOffset evaluationswill be followed by two optimization iterations
(based on previously unsolvedOffset values) before the goal is satisfied. So, by taking
advantage of the prior parametric sweep results, the goal is achieved with one fewer
optimization iteration (even though the analysis results will show thirteen data points
instead of four).

Note:

The additionalOffset variants that are evaluated and the final optimized value will
differ between these twomethods, but both will satisfy the acceptableCost cri-
terion of 0.001.

3. Ensure that theUpdate design parameters' value after optimization option is selected.

This option causes themodel geometry to be updated with the optimized septum position at
the completing of the optimization analysis.
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4. Go to theOptions tab and deselect theSave Fields And Mesh option, if it is selected.

Figure 4-6: Setup Optimization Dialog Box – Options Tab

Note:

You do not need the field solutions for theOffset values that are solved as the pro-
gram tries to reach the acceptable cost goal.

5. ClickOK to close theSetupOptimization dialog box.

The optimization setup is now complete.

6. UnderOptimetrics in the Project Manager, right-clickOptimizationSetup1 and chooseAna-
lyze.

The solution process is expected to take approximately 1 - 3minutes, depending on your
computer hardware.While the solution is running, proceed to the next chapter to follow the
progress of Optimetrics as it searches for the acceptable cost value.
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5 - Review the Optimization Results
In this chapter you will complete the following tasks:

l View the cost value versus completed iteration in x-y plot and data table formats.
l Re-run the analysis at the septum’s optimal position.
l Review the E-field results at the septum’s optimal position.
l Close the project and exit HFSS software.

View the Cost vs. Solved Iteration
As the solution progresses, view the cost values versus completed iterations in rectangular (X-Y)
plot format. The plot indicates how closeOptimetrics is to reaching the goal value of 0.

1. Right-clickOptimizationSetup1 in the Project Manager, and then chooseView Analysis
Result from the shortcut menu.

ThePost Analysis Display dialog box appears.

2. Under theResult tab, selectPlot.

A plot of the cost value at each iteration appears.

Figure 5-1: Cost vs. Iteration Plot

The optimization stopswhen it reaches aCost value at or below the acceptable cost you spe-
cified (0.001).
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3. Select Table.

The cost value at each solved design variation is listed in table format.

Figure 5-2: Cost vs. Iteration Table

Make amental note of the optimizedOffset value, which should be between 0.09 and 0.1
inch.

4. ClickClose.
5. From themenu bar, clickHFSS> Design Properties.

Notice that the value of theOffset variable has been updated to the optimization result that
satisfied the acceptable cost criterion:

Figure 5-3: Updated Offset Value

Optional Exercise:
If you would like to compare the optimization behavior just reviewed to that of preforming optim-
ization using the previous parametric sweep results, do as follows:
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1. Right-clickOptimizationSetup1 in the Project Manager and chooseDelete.

Note:

Deleting and recreating the optimization setup is necessary to see a change in the
optimization iterations. Otherwise the previously run septum offset valueswill
simply be reevaluated. It is not sufficient to clean up the previous results (via
HFSS> Results> Clean Up Solutions) because the optimization setup will
retain the history of priorOffset guesses.

2. Return to the Add anOptimization Setup procedure and identically repeat all of the instruc-
tions from there through thisReview theOptimization Results procedure, except for the fol-
lowing change:

When you reach step 2 of theSolve theOptimization procedure, chooseParametricSetup1
instead ofN/A. The other settings on theGeneral tab can remain at their defaults.

This time, after performing the optimization, the analysis results plot and table should
resemble the following two figures:

Figure 5-4: Cost vs. Iteration Plot (Using ParametricSetup1)
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Figure 5-5: Cost vs. Iteration Table (Using ParametricSetup1)

For the first 11 iterations, Optimetrics referred to the results from the previously run para-
metric analysis. Optimetrics extracted the cost values from the 11 design variations solved
during the parametric analysis and then performed two additional iterations before satisfying
theCost criterion.

Reanalyze Design at Optimal Septum Offset
A field solution is unavailable at the optimal value; therefore the field overlay plotMag_E1 is con-
sidered invalid in its current state. To update the plot, solve the HFSS analysis setup with theOffset
variable at the optimal value.

Note:

The optimizedOffset value will be slightly different for those who chose to complete the
Optional Exercise in the preceding topic versus those who chose not too do so. The res-
ults presented in this guide are based on the optimization results from theOptional Exer-
cise procedure.

1. Under Analysis in the Project Manager, right-clickSetup1 and chooseAnalyze from the
shortcut menu.

The analysis is expected to take approximately 1minute to complete.
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Update the Field Overlay
1. Double-click the field overlay plotMag_E1 to view the updated plot in the view window.

The E-field values indicate that the fields are approximately twice as great moving toward
Port3 as they aremoving toward Port2.

Figure 5-6: Mag_E1 Field Overlay with Septum at Optimal Position

Close the Project
Congratulations, you have successfully completed thisTeeWaveguideOptimization exercise!
However, if you have theANSYSWorkbench software (in addition to ANSYS Electronics
Desktop), then you also have the included SpaceClaimCAD solid modeling application. In that
case, youmaywant to continue to theSpaceClaim to HFSS Link section. In this final section of the
guide, you can learn how to have your SpaceClaimCAD geometry linked to an HFSS Optimetrics
model. In this way, your CAD models can be updated automatically based on HFSS optimization
analyses run in the ANSYS Electronics Desktop (EDT) software.

If you choose to continue to theSpaceClaim to HFSS Link section, you will be using an example
model that was installed with the EDT software, rather than further modifying theOptimTee project
you just created. So, you can close the current model in any case.
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1. Save your project.
2. Choose one of the following actions:

l If you want to immediately proceed to theSpaceClaim to HFSS Link section, click
File> Close from themenu bar, but do not exit the application.

Note:

Also choose this action if you are not going to perform the SpaceClaim exer-
cise but you want to leave the EDT application open for other purposes.

l If you want to close themodel and also exit the application, clickFile> Exit from the
menu bar.
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6 - SpaceClaim to HFSS Link
In this chapter you will complete the following tasks:

l Prepare the OptimTeeGeometry and Import into SpaceClaim
l Create SeptumParameters in SpaceClaim
l AssignWave Ports
l Set UpHFSS Optimetrics
l Analyze and Review Parametric Results

Prepare the OptimTee Geometry and Import into
SpaceClaim
Youwill first open theOptimTee examplemodel in ANSYS Electronics Desktop and export the geo-
metry as an ACIS (*.sat) format file. You can then import the geometry into SpaceClaim. In prac-
tice the SpaceClaim geometry could come from any source.

1. With ANSYS Electronics Desktop launched but no project currently open: On the Desktop
ribbon tab, clickOpen Examples.

2. In theOpen dialog box, navigate to the ...\Examples\HFSS\RFMicrowave subfolder, select
theOptimTee project, and clickOpen.

Figure 6-1: Opening the OptimTee Example Project
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3. On theDesktop ribbon tab, click Save As and then:
a. In the File name text box, typeOptimTee_SC.
b. Navigate to a working folder of your choice.

Note:

You cannot write to theExamples branch, which is within the operating sys-
tem'sProgramFiles path. You can use the same folder that you did for your
OptimTee project, since you're specifying a different file name for this project.

c. ClickSave.
d. In theHandle Project Directory Files dialog box, selectCopy File to New Project

Directory and Don't Overwrite from theChange Action for All Files drop-down
menu.

e. ClickOK.
4. UnderModel> Solids> vacuum in the History Tree, select Tee.
5. From themenu bar, clickModeler> Export.
6. In theExport File dialog box, chooseACIS SAT Files (*.sat) from theSave as type drop-

downmenu. (In practice, the format can be any supported by SpaceClaim.)
7. Navigate to the folder where you saved theOptimTee_SC project (in step 3b).
8. In the File name text box, typeOptimTee_SC and then clickSave:

Figure 6-2: Exporting the ACIS SAT File

9. ClickOK to select the defaultACIS SAT Version.
10. Launch SpaceClaim by findingSCDM 20xx in your ANSYS 20xxStart Menu folder.
11. In SpaceClaim, select File> Open and then:

a. From the drop-downmenu to the right of the File name text box, selectACIS
(*.sat;*.sab;*.asat;*.asab).

b. Navigate to the working folder you specified in steps 3b and 7.
c. Select the file,OptimTee_SC.sat.

Figure 6-3: Opening ACIS SAT File in SpaceClaim
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12. TheOptimTee_SCmodel opens in SpaceClaim:

Figure 6-4: OptimTee_SC Model in SpaceClaim

Create Septum Parameters in SpaceClaim
1. FromSpaceClaim'sDesign ribbon tab, clickSelect> Using Box:

Figure 6-5: Choosing Selection Mode
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2. Click and drag from left-to-right to draw a selection box enclosing the septum faces:

Figure 6-6: Selecting the Septum Faces

Yellow highlighting showswhich faceswill be selected when you release themouse button.
After you do, the selected faces are rendered in orange.

3. On the Display ribbon tab, click Move.

A Move Handle appears to facilitate translational and rotational movement about local
coordinate system axes. The initial origin of theMove Handle is at the centroid of the selec-
ted set of faces.

4. Click the green Y axis of theMove Handle and drag vertically upward an arbitrary distance.

A small yellow dot is visible at the original reference point for themove operation (indicated
by a black arrow on the following figure):

Figure 6-7: Reference Point for Move Operation
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Note:

The examplemodel that was exported as an ACIS SAT file, and was the basis of
this SpaceClaimmodel, had the Septum centered (at Offset = 0). Therefore, this
reference point lies on the X-axis, and theMove dimension represents the distance
the Septum is offset in the +Y direction from its centered position. It is possible to
move the reference point for aMove operation to amoremeaningful location when
that would be beneficial (such as to a vertex or themidpoint or an edge). However,
that step is not needed for this example.

5. Now, click in the dimension box that's located near the reference point, type 3mm to specify
an exact dimension, and pressEnter.

Figure 6-8: Exact 3mm Y-Dimension Specified

6. Click the letter P to the right of the dimension box to create a new modelParameter.

A new Driving Dimension parameter is created asGroup1 and appears in theGroups panel
to the left of the drawing canvas:

Figure 6-9: Group1 Ruler Dimension Created
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7. Right-clickGroup1 and selectRename from the shortcut menu. Change the name toOff-
set and pressEnter.

This dimension controls the offset of the Septum in the Y direction. You will use this para-
meter in HFSS to run a parametric analysis.

8. ClickRuler dimension to the right ofOffset to display the current dimension:

Figure 6-10: Current Dimension of Offset Parameter

9. ClickFile>Save As.

After a brief delay, theSave As dialog box appears.

10. Ensure that the following specifications are correct and then clickSave:
l File name isOptimTee_SC
l Save as type isSpaceClaim files (*.scdoc)
l The folder is the same aswhere you saved theOptimTee.aedt andOptimTee.sat
files.

Set Up the SpaceClaim Link from HFSS
In ANSYS Electronics Desktop, theOptimTee_SC project should still be open. Next, you will cre-
ate a link to the SpaceClaimmodel and delete the original Tee object.

Note:

The SpaceClaimmodel's default length unit ismillimeters (mm). The dimensionswill be
converted to the ANSYS Electronics Desktop project'smodel units, resulting in the cor-
rect Septum location but represented in inches.

1. Choose one of the following twomethods of accessing theOptimTee_SC.sdocSpaceClaim
model fromANSYS Electronics Desktop:

l If SpaceClaim is running and the subject model (OptimTee_SC) is already open in
SpaceClaim:

Using themenu bar, clickModeler> SpaceClaim Link> Connect to Active Ses-
sion, selectOptimTee_SC, and clickConnect:
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Figure 6-11: Link by Connecting to Active SpaceClaim Session

l If SpaceClaim is not currently running or a different model is open in SpaceClaim:

Using themenu bar, clickModeler> SpaceClaim Link> Browse, navigate to the
model folder, selectOptimTee_SC.scdoc, and clickOpen.

Figure 6-12: Link by Browsing to SpaceClaim Model

There are now two Tee objects in theModeler window:

l The original Tee that you exported to an ACIS SAT file (listed underModel>
Solids> vacuum)

l The linked SpaceClaim geometry,OptimTee_SC, which has a different
septum offset, (listed underModel> SpaceClaim1> Solids> vacuum).
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Figure 6-13: ANSYS Electronics Desktop Model with Link to SpaceClaim
Model Added

2. In the History Tree, select the original Tee object and pressDelete.

Only the linked geometry should be retained.

Note:

An alternative approach would be to create a new project in Electronics Desktop
and insert an HFSS design. Then, link that project (with its empty HFSS design) to
the SpaceClaimmodel. Only the linked geometry would exist in the project.

3. Save themodel.
4. Select theSpaceClaim1 entry in the History Tree to see its details in the dockedProperties

window. Select theParameters tab to see the variable transferred fromSpaceClaim:

Figure 6-14: Offset Variable from Linked SpaceClaim Model
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TheOptimTeemodel was originally defined in Electronics Desktop using the English inch
length unit. Therefore, theOffset parameter value of 3mm from the linked SpaceClaim
model is shown using the HFSSmodel's length unit (0.11811 inch = 3mm).

Assign Wave Ports
1. PressF to begin Face Selectionmode.
2. DefineWave Port excitations on each of the three end faces of the T-junction waveguide,

as follows:

Figure 6-15: Assigning Wave Port Excitation to a Face via the Shortcut Menu

Assign the wave ports to the faces in the following sequence and keep the default port
names:

a. Middle input port (+X end face), Name = "1"
b. Right output port (+Y end face), Name = "2"
c. Left output port (-Y end face), Name = "3"
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Important:

Define the Integration Line for each port from themidpoint of the face's bottom
edge to themidpoint of the face's top edge. For a refresher on how to do this, nav-
igate to the following help topic:

HFSS> HFSS TeeWaveguide Junction> Create the TeeModel> Assign a
Wave Port to the Box

When you have added theWave Port for each face, the excitations are listed in the Project
Manager:

Figure 6-16: Wave Port Excitations in Project Manager

3. Under Analysis in the Project Manager, double-clickSetup1 to edit its properties. (This
setup was predefined in theOptimTee examplemodel.)

TheDriven Solution Setup dialog box appears.

4. Increase theMaximum Number of Passes to 12. Keep the 10GHz Frequency and 0.02
MaximumDelta S settings. ClickOK.

5. Add a Frequency Sweepwith the following settings:
l Sweep Type: Interpolating
l Distribution: Linear Step
l Start: 8GHz
l End: 10GHz
l Step size: 0.05GHz
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Figure 6-17: Sweep Settings

6. Save your model.

Setup HFSS Optimetrics
1. Select theSpaceClaim1 entry in the History Tree and view theParameters tab of the

dockedPropertieswindow.
2. In theValue column of theOffset parameter, enter a new variable,Offset1, set its initial

value to 3 mm, and clickOK:
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Figure 6-18: Defining Variable Offset1 for Linked Parameter Offset

This step is needed for HFSS to be able to vary the septum position for the Optimetrics ana-
lysis.

3. UnderOptimetrics in the Project Manager, double-clickParametricSetup1 to edit its set-
tings. (This setup was predefined in theOptimTee examplemodel.)

TheSetup Sweep Analysis dialog box appears.

4. Select the variable, offset and clickEdit.

TheAdd/Edit Sweep dialog box appears.

5. Change the sweep variable settings as follows:
a. From theVariable drop-downmenu, selectOffset1 and keep the Linear step option

selected.
b. Start = 0 mm
c. Stop = 10 mm
d. Step = 1 mm
e. ClickUpdate to revise theVariable andDescription on the right side of the dialog box.

(If you fail to do so, the changeswill be discarded when you close theAdd/Edit Sweep
dialog box.)
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Figure 6-19: Editing the Parametric Sweep Variable

6. ClickOK to close theAdd/Edit Sweep dialog box.
7. Select theCalculations tab of theSetup Sweep Analysis dialog box. Then, select and

Delete each of the three existing calculation rows.

Note:

These previously defined power calculations are no longer valid because the linked
model has different port names than the original model did. Also, for this
SpaceClaim-to-HFSS link exercise, you will not need the port power calculations.

8. Select theOptions tab of theSetup Sweep Analysis dialog box and ensure that theSave
Fields and Mesh option is selected.

9. ClickOK.
10. UnderOptimetrics in the Project Manager, selectOptimizationSetup1 and pressDelete.
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11. Right-clickSpaceClaim1 in the History Tree and selectSend Parameters and Generate.

Figure 6-20: Sending Updated Parameters to SpaceClaim

Note:

If you saved your project after revising the variables and parametric setup, the
Send Parameters andGenerate commandwill be unavailable (because updating
the SpaceClaim parameters is part of the Save process). The command is only
available when there are unsaved changes to send.

Analyze and Review Parametric Results
1. In the Project Manager, right-clickParametricSetup1 and chooseAnalyze from the short-

cut menu:
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Figure 6-21: Analyzing the Parametric Setup

As the Parametric analysis runs in HFSS, the bi-directional link updates the geometry in
SpaceClaim:

Figure 6-22: Offset Parameter Being Updated in SpaceClaim

The analysis will take between five and tenminutes to complete, depending on your com-
puter hardware.

Review the Analysis Profile:

2. In the Project Manager, right-clickParametricSetup1 and chooseView Analysis Result.

3. Select theProfile tab of the Post Analysis Display dialog box to view information about each
variation solved:
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Figure 6-23: Post Analysis Display Dialog Box – Profile Tab

4. ClickClose.

Generate a Plot of S(1,3) vs.Offset1 for Several Frequencies:

5. On theResults ribbon tab, click Modal Solution Data Report> 2D.
6. In theContext section of theReport dialog box, ensure that:

a. Solution = Setup1 : Sweep
b. Domain = Sweep

7. Under the Trace tab, specify the following settings:
a. ChooseOffset1 from thePrimary Sweep drop-downmenu and ensure thatAll

appears next to this setting.
b. Category: S Parameter
c. Quantity: S(1,3)
d. Function: dB

8. Under the Families tab, do the following:
a. Select theAvailable variations option.
b. Select only five of the Freq values: 8, 8.5, 9, 9.5, and 10 GHz.
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9. ClickNew Report andClose.

The resulting plot shows the initially steep increase in the transmission to port 3 as the
septum offset increases. Then, the port 3 output levels off and begins to decrease again as
the offset is increased further. The extremumof the curve varies with frequency. The lower
the frequency, the lower the offset at which the extremumoccurs:

Figure 6-24: S(1,3) Parameter (dB) vs. Offset1 for Five Frequencies

Congratulations. You have completed theSpaceClaim to HFSS Link exercise of theOptimizing a
Waveguide T Junction guide. At this time, you can save and close your ANSYS Electronics
Desktop and SpaceClaimmodels.
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